# Contents

1. Copyright Notice ................................................................................................................................. 4  
   1.1. Third party license information .................................................................................................. 5  

2. What is Shuttle? ...................................................................................................................................... 19  
   2.1. Shuttle Client/Server Configuration ......................................................................................... 19  
   2.2. Shuttle Setup Overview .......................................................................................................... 19  

3. Configuring Shuttle in Automation Engine ....................................................................................... 21  
   3.1. Making Tickets Public ............................................................................................................. 22  
   3.2. Using Public Parameters in Automation Engine ....................................................................... 22  
      3.2.1. Making a Parameter Public .............................................................................................. 22  
      3.2.2. Managing Public Parameters in Your Ticket ................................................................. 24  
      3.2.3. SmartNames in Public Parameters .................................................................................. 27  
   3.3. Setting Up Operator Routing in Your Workflow ........................................................................ 28  

4. Odystar Setup for Shuttle .................................................................................................................... 31  
   4.1. Connection Setup ..................................................................................................................... 31  
      4.1.1. Creating an Odystar Spool Folder ...................................................................................... 33  
   4.2. License Expiry Notification Setup ............................................................................................. 33  
   4.3. Access Rights Setup ................................................................................................................ 34  
   4.4. Parameter Assistant Setup ......................................................................................................... 35  
      4.4.1. Setting up a Database for the Parameter Assistant ............................................................ 37  
   4.5. Shuttle Parameters in Odystar Receive Process Folders ............................................................ 38  
   4.6. Making Parameters Public for Shuttle in Odystar ................................................................. 40  
   4.7. Setting up the Hold Process Folder for Shuttle ........................................................................ 41  

5. Nexus Setup for Shuttle ....................................................................................................................... 43  
   5.1. Setting up the NexusSOAPServer ............................................................................................. 43  
      5.1.1. Setting up a Shared Folder or a HotFolder for Shuttle ...................................................... 45  
      5.1.2. Making Nexus Broadcast over Bonjour ............................................................................. 45  
      5.1.3. Setting up a Database for the Parameter Assistant ............................................................ 46  
      5.1.4. Connecting Nexus to your Database .................................................................................. 47  
   5.2. Enabling Shuttle in a Nexus Hot Folder .................................................................................... 48  
   5.3. Making Parameters Public for Shuttle in Nexus ................................................................. 49  
   5.4. Setting up the Wait for OK Activity for Shuttle ....................................................................... 53  
   5.5. Setting up the Decision Activity for Shuttle ............................................................................. 54  

6. Shuttle Clients Setup ............................................................................................................................ 58  
   6.1. Connecting your Shuttle Client to your Workflow Server ........................................................ 58  
      6.1.1. Shuttle Clients Connecting to Any Server ........................................................................... 58  
      6.1.2. Shuttle Clients Connecting only to Automation Engine .................................................... 60
6.2. Defining Preferences
6.2.1. Display Preferences
6.2.2. Public Parameters Preferences
6.2.3. Filtering Preferences
6.2.4. Workflow Units Preferences

7. Launching Files into a Workflow
7.1. Launching Tasks from Adobe Illustrator (the Shuttle Plug-in)
7.2. Launching Tasks from ArtPro
7.3. Launching Tasks from Neo
7.4. Launching Tasks from PackEdge or Plato
7.5. Launching Tasks from FastImpose

8. Monitoring Files
8.1. The Shuttle Window
8.1.1. The Shuttle Window Buttons
8.1.2. The Connection to Workflow Servers
8.1.3. The Shuttle Window Filter
8.1.4. The Files List
8.1.5. The Context Menu
8.1.6. The Inspector Panel
8.1.7. Showing Only Your Files / Everybody's Files

9. Working with Shuttle when your File is Processing
9.1. Opening Files / the Enclosing Folder
9.2. Changing a File's Public Parameters
9.3. Holding or Releasing a File
9.4. Changing a File's Priority
9.5. Opening the Log
9.6. Routing Files that Need a Decision
9.7. Deleting a File from your Workflow
1. Copyright Notice

© Copyright 2019 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com

1.1. Third party license information

This product includes Bonjour SDK.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of Apple Computer, Inc. (“Apple”) nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes Botan.

Copyright (C) 1999-2009 Jack Lloyd
2001 Peter J Jones
2004-2007 Justin Karneges
2005 Matthew Gregan
2005-2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007-2008 FlexSecure GmbH
2007-2008 Technische Universitat Darmstadt
2007-2008 Falko Strenzke
2007-2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cereal.

Copyright (c) 2014, Randolph Voorhies, Shane Grant

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of cereal nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL RANDOLPH VOORHIES OR SHANE GRANT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm ColourKit Profiler Suite (www.colourprofiling.com)

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and SWOP(R) are all registered trademarks of IDEAlliance(C).

------------------------------------------------------------

This product includes PANTONE Color Libraries.

PANTONE® and other Pantone trademarks are the property of Pantone LLC. Pantone is a wholly owned subsidiary of X-Rite, Incorporated.

------------------------------------------------------------

This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>. All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

------------------------------------------------------------

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------

This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.

Copyright 2005-2006 Feeling Software and
Copyright 2005-2006 Autodesk Media Entertainment.

Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------

This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License.

All rights reserved.

------------------------------------------------------------

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library
Copyright (C) 2002-2007, Milan Ikits <milan ikits[@]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[@]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of the author may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version: 7.0
Copyright (C) 1999-2007 Brian Paul  All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and/or associated documentation files (the "Materials"), to deal in the Materials without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Materials, and to permit persons to whom the Materials are furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.

------------------------------------------------------------
This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL
SOFTWARE, SHUTTLE BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. 
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY 
DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED 
SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL 
/N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, 
PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, 
HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR 
INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N 
SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE 
POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF 
LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

------------------------------------------------------------

This product includes IP*Works! SSL.
Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE 
SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING 
THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN 
TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE 
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED 
BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE 
LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR 
INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS 
REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, 
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE 
SUPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE 
COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL 
DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY 
DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE 
LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE 
SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. 
/N SOFTWARE’S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY 
DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED 
SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL 
/N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, 
PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, 
HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR 
INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N 
SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE 
POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF 
LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

------------------------------------------------------------

This product includes JBIG2Lib.
Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

------------------------------------------------------------

This product includes JPGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
This product includes Little CMS.

Little CMS
Copyright (c) 1998-2011 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

This product includes leptonica.

- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions
  are met:
  - Redistributions of source code must retain the above copyright
    notice, this list of conditions and the following disclaimer.
  - Redistributions in binary form must reproduce the above
    copyright notice, this list of conditions and the following
    disclaimer in the documentation and/or other materials
    provided with the distribution.
- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
  "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
  A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY
  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes libpng.

Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,
including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special, exemplary,
or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.
There is no warranty against interference with your enjoyment of the
library or against infringement. There is no warranty that our
efforts or the library will fulfill any of your particular purposes
or needs. This library is provided with all faults, and the entire
risk of satisfactory quality, performance, accuracy, and effort is with
the user.
This product includes libxml2.

Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonin Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, FreeImage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------------------

This product includes OpenSSL.

Copyright (c) 1998-2017 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------------------

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
   "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"
   The word 'cryptographic' can be left out in the routines from the library being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement:
   "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes PCRE.

Copyright (c) 1997-2016 University of Cambridge
All rights reserved.

Copyright(c) 2010-2016 Zoltan Herczeg
All rights reserved.

Copyright(c) 2009-2016 Zoltan Herczeg
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the names of any contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes patented technology.

This product and use of this product is under license from Markzware under U.S. Patent No. 5,963,641.
This product includes Qt.

The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).

This product includes QtMigration.

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes tesseract.

Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution.
This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

------------------------------------------------------------

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice,
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice,
  this list of conditions and the following disclaimer in the documentation
  and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its
  contributors may be used to endorse or promote products derived from this
  software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes xxHash.

xxHash Library
Copyright (c) 2012-2014, Yann Collet
All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this
  list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this
  list of conditions and the following disclaimer in the documentation and/or
  other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes zlib.

(C) 1995-2017 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly        Mark Adler
jloup@gzip.org          madler@alumni.caltech.edu

------------------------------------------------------------
This product includes ZXing C++ Library.

NOTICES FOR C++ Big Integer Library

I, Matt McCutchen, the sole author of the original Big Integer Library, waive my copyright to it, placing it in the public domain. The library comes with absolutely no warranty.

------------------------------------------------------------
2. What is Shuttle?

The Automation Engine Shuttle is a client tool for easy submission of files to Automation Engine workflows. Shuttle also allows monitoring of the workflows.

The Shuttle functionality is also integrated in ArtPro, Neo, PackEdge, Plato, FastImpose and in Adobe Illustrator as a DeskPack plug-in. This enables to launch tasks from inside these editors. This setup is described in this documentation.

2.1. Shuttle Client/Server Configuration

<table>
<thead>
<tr>
<th>You can submit files to...</th>
<th>with those Shuttle clients...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Engine</td>
<td>• Shuttle plug-in</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in Neo</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in ArtPro</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in PackEdge</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in Plato</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in FastImpose Server or Standalone</td>
</tr>
<tr>
<td>Odystar</td>
<td>• Shuttle plug-in</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in Neo</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in ArtPro</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in FastImpose Standalone</td>
</tr>
<tr>
<td>Nexus</td>
<td>• Shuttle plug-in</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in Neo</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in ArtPro</td>
</tr>
<tr>
<td></td>
<td>• Shuttle in FastImpose Standalone</td>
</tr>
</tbody>
</table>

2.2. Shuttle Setup Overview

To use Shuttle to monitor and submit files to your workflow server, you need to set up your server, your Shuttle client, and make sure they can exchange files via a shared folder.

**Workflow Server Setup**

Set up your workflow server for Shuttle in either:

- the Odystar Hub (see Odystar Setup for Shuttle),
- the NexusSOAPServer (see Nexus Setup for Shuttle),
- Automation Engine’s Configure tool (see Configuring Shuttle in Automation Engine on page 21).
Shuttle Client Setup

Set up your Shuttle client in the applications you use. See Shuttle Clients Setup on page 58.

Shared Folder Setup

You also need to make sure that the relevant servers’ shared folders are mounted on the Shuttle clients machines, with the appropriate Read and Write permissions.

- For Odystar, see Creating an Odystar Spool Folder.

- For Nexus, see Setting a Shared Folder or a HotFolder for Shuttle.

- For Automation Engine, the shared folder is either an Automation Engine Container, or an Upload Folder you set up in Configure. See Configuring Shuttle in Automation Engine on page 21.
3. Configuring Shuttle in Automation Engine

1. In the **Pilot**, go to **Tools > Configure**.
2. Select **Shuttle** in the left pane.

![Configure Shuttle in Automation Engine](image)

3. Enter the **Port** to use for communication between your Automation Engine server and the Shuttle clients.

   **Note:** By default this is port 5182, but if this port is already used by other processes, you should enter the next available port.

4. Click on **and select an Upload Folder**.
   
   This is where Shuttle clients will upload files that are not located in a Container (except the Shuttle plug-in, that will always upload files to the **DeskPackContainer**).

   **Note:** The Upload Folder must be located in a Container.

5. Select **Start Shuttle server automatically when Automation Engine is started** if you plan to make frequent use of the Shuttle technology.

6. Select **Use the task history to re-launch using the same public parameters** if you want Shuttle to propose to use the same public parameters when you launch a same file on the same workflow. The Shuttle then checks prior tasks both in the Tasks Monitor and in the **Task History** tool.

7. Click the **Start** button to start Shuttle server.

   The Shuttle server now makes Automation Engine's workflows, tasks and files accessible to the Shuttle clients.

8. Save your settings.
3.1. Making Tickets Public

Only Public tickets (of single tasks or workflows) can be launched from Shuttle (or from the client applications using Shuttle).

Learn about making (workflow) tickets public [here].

**Note:** Default tickets and (blue) Job tickets can not be made public.

3.2. Using Public Parameters in Automation Engine

**Concept**

Users often do not want or have to see all the parameters of a chosen task ticket. You can make them see and define only the parameters that you decided to make **Public**. Seeing less options makes it simpler and helps reduce mistakes.

Ticket parameters that are made **Public** will be the only parameters visible to users when they want to launch tasks from:

- Automation Engine client applications: Pilot and Shuttle

**Note:** Only **Public Tickets** can be launched from these client applications or editors.

For each **Public Parameter**, you can decide if the user can either:

- select a value from a list,
- enter a value himself.

3.2.1. Making a Parameter Public

**Note:**

- Not all ticket parameters can be made public.
- Parameters need to be made public before you start the workflow that their ticket is part of.

Open the ticket and follow these steps:

1. Right-click the parameter and select **Make Parameter Public**.
2. Right-click it again and select **Modify Public Parameter...**
3. In the **Modify Public Parameter** dialog that opens:
   a) **Prompt as**: If you want, change the way the parameter will be called in the client application.
b) Choose either:

- **Allow the user to set the value**: Select this if you want users to be able to freely enter a value.

  ![Modify Public Parameter](image)

- **Let the user select a predefined value**: Select this if you want users to choose from a list of values that you define.

  ![Modify Public Parameter](image)

**Note**: Users will only see (and choose from) the **Predefined Settings**. They will not see the associated **Values**.

In the above example, this is how the public parameter will look like to the users of the client application:

<table>
<thead>
<tr>
<th>If you chose ‘<strong>Allow the user to set the value</strong>’</th>
<th>If you chose ‘<strong>Let the user select a predefined value</strong>’</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Custom Resolution" /></td>
<td><img src="image" alt="Custom Resolution" /></td>
</tr>
</tbody>
</table>

If, in the ticket, that parameter already offers a list of values to choose from, they will be displayed here.

**Default Predefined Setting**: You can here define the setting that will be used when the user didn't select another one.

4. Click **OK**.
3.2.2. Managing Public Parameters in Your Ticket

The Manage Public Parameters... dialog of a ticket is where you overview and manage its public parameters.

1. In your ticket, go to Advanced > Manage Public Parameters...

![Manage Public Parameters dialog]

The left pane shows all parameters that can be made public for this ticket. The ones you already made public are greyed out.

The right pane shows the public parameters and their settings.

2. You can:
   - drag parameters from left to right to make them public
   - click [x] if you don't want it to be public anymore
   - drag them up or down to rearrange the order that they will be shown to the user.
   - change public parameters' settings (Prompt as, Predefined Settings, etc.)
   - group public parameters under a custom header (click Add Group, click [pencil] to edit the header and drag parameters from the left). An example:
• use **Presets** to further simplify the users' choices (see *Making Presets to Simplify the Users’ Choices* on page 25).

**Making Presets to Simplify the Users’ Choices**

**Presets** are customized combinations of parameters. They limit the amount of decisions that users have to make.

**Example**

Let's assume you want users to use different trapping settings when printing offset versus dry offset. You can collect those trapping settings in a **Preset**, so that users will only have to choose between 'offset' and 'dry offset'.

We start from a dialog of a workflow ticket where the trapping step has 3 public parameters:

1. Click to remove the (default) **Group** named "Trap with PowerTrapper"
2. Click **Add Group**.
   
   A new "Untitled Group" is created. Click to change its name.
3. Click **Add Preset**.
   
   A new "Preset" is created. Click to change its name.

   By default, two example values will appear. The preset was renamed to 'Choosing Process to Decide Traps':
4. Define what the users will see:
   a) in **Prompt as**, enter the text that users will see (replacing 'Type the name of the preset here (e.g. “Paper Size”)')
   b) enter the values that the users will choose from (replacing 'Type a value here (e.g. A4)'). In our example, we add 'Offset' and 'Dry Offset'.

   Click **Add** if you want to add extra values (not the case in our example).

5. Drag the parameters from the dialog's middle pane onto one preset item. This will make them automatically appear under each preset item (here both under **Offset** and **Dry Offset**).
6. Define the parameters values for each preset item.
   See the above screen shot for a good example.
7. Use the buttons Move Up / Down to define the order of the Presets in the panel that the end-user will see.
8. Click OK to confirm and close the dialog.
9. Save your ticket to also save these public parameters.

This is how the resulting dialog will look like to the users of the client applications:

3.2.3. SmartNames in Public Parameters

You can use SmartNames in your public parameters (for parameters taking SmartNames as input).
In Shuttle, use square brackets around SmartNames when submitting a file with public parameters.
3.3. Setting Up Operator Routing in Your Workflow

You can build your workflow so that users will route your files based on their expertise. They will get a notification, and the processing will be paused until they decide where to send the file.

To use this in your workflow:

1. Add the **Wait for Action (Checkpoint)** step to your workflow.
2. Double-click the step to open its settings.
3. Create the notification that will be sent:
   a) Choose which user you want to send it to
   b) Enter a **Subject**
   c) Add a **Message** if desired
4. Choose a **Due date**. Either:
• choose one of the predefined due dates (from Immediate to Next sunday),
• choose Other... in the Due date list and pick the due date yourself.

5. In Output states, define the output possibilities you want for your checkpoint.
   By default, this step has two outputs: Completed and Aborted.
   To add an output:
   a) Click Add
   b) Enter the output's name
   Add as many outputs as you like.

6. If necessary, use the Move Up and Move Down buttons to display your outputs in a
   different order.
   
   Note: You can Remove the default outputs if you don't need them.

7. If you want your file to be automatically sent through one of the outputs if no action is
   taken by the operator after a period of time:
   a) Select Release automatically
   b) Enter the time delay after which the file should be released
   c) Choose the output to release the file to

8. Click OK to apply your settings.
9. On your canvas, the **Checkpoint** step has the outputs you defined. Connect each output to the appropriate step.

Operators will be able to route files gone through the **Checkpoint** from the Pilot's **Tasks** pane, the workflow editor, or Shuttle.
4. Odystar Setup for Shuttle

Odystar's Hub application makes the Odystar Canvases and jobs accessible to the Shuttle clients.

4.1. Connection Setup

1. On your Odystar server, launch the Hub application. You can find it in Odystar's Server Software folder.
2. Go to Hub > Preferences. You can also use the shortcut Command + , (comma).
3. In the Shuttle tab, configure the Server parameters (that you will use to find your Hub from Shuttle or Shuttle plug-in).

   a) Enter the IP Address of the server running your Hub, and the port to use for SOAP communication between Shuttle and Hub (in Shuttle Port).
   
   Note: By default this is port 5182, but if this port is already used by other processes, you should enter the next available port.

   b) If you want to broadcast your Odystar server over the Apple Bonjour™ network, enter a Bonjour Name for it.

4. Create a Spool Folder with appropriate permissions for Shuttle users. See Creating an Odystar Spool Folder.
5. Browse to your Spool Folder.
6. Define how Shuttle applications on client machines can access your Spool Folder: in **Spool Folder URLs**, click the + button. This opens the following popup:

<table>
<thead>
<tr>
<th>If your Spool Folder is located...</th>
<th>Then you should...</th>
</tr>
</thead>
</table>
| **...on the server running your Hub:** | 1. Choose **Automatic**.  
2. Select your Spool Folder in the **Shared Folder** menu (which contains all shared folders on your server).  
3. Choose the **Protocol** you want to use: choose **afp** to access the Spool Folder from Shuttles on Mac machines, or **smb** to access it from Shuttles on Windows machines. |
| **...somewhere else in your network - or if it is on the server running your Hub but you need to define its URL manually:** | 1. Choose **Manual**.  
2. Enter the **URL** of your Spool Folder, including the protocol. Your URL should look like `afp://<server>/<spool folder path>` or `smb://<server>/ <spool folder path>`. |
**Note:** Add both an **afp** and a **smb** URL if some Shuttle users have Mac machines and other have Windows machines. You can only define one afp and one smb URL.

### 4.1.1. Creating an Odystar Spool Folder

The **Spool Folder** is used to submit jobs from Shuttle applications to Odystar Canvases. Shuttle or the Shuttle plug-in copy jobs to the Spool Folder, and Odystar Receive Gateways pick them up for processing.

1. Create the folder you want to use as a Spool Folder.
   
   We strongly recommend you create your Spool Folder on the machine running your Odystar Hub.

2. Share your Spool Folder, and give all Shuttle users Read and Write permissions for it.
   
   - If your Odystar server is a Mac OS 10.5.x, go to **System Preferences > Sharing** to share your Spool Folder.
   - If your Odystar server is a Mac OS 10.4.x, you need to use the **SharePoints** application to share your Spool Folder. You can download this application for free from [http://www.hornware.com/sharepoints/](http://www.hornware.com/sharepoints/).

3. If the Spool Folder has the required permissions, your Shuttle applications can auto-mount it when you submit a job to a workflow.

   If Shuttle fails to auto-mount your spool folder, mount it manually on your Shuttle client machine(s).

### 4.2. License Expiry Notification Setup

At the bottom of the **Shuttle** tab, choose how to notify Shuttle users of the expiry of Odystar licenses.

![Software Expiry](image)

Choose between:

- **No users are notified through Shuttle,**
- **All users are notified through Shuttle,**
- **Only specified users are notified through Shuttle.** In this case, enter the **Users** to notify, separating their names by commas.
4.3. Access Rights Setup

1. In the Hub's Preferences, go to the Access Rights tab.

2. Choose which users can delete which jobs:
   - Users can only delete their own jobs,
   - All users can delete all jobs,
   - Only specified users can delete all jobs. In this case, enter the Users that can delete all jobs, separating their names by commas.

3. Choose which users can change the priority of which jobs:
   a) Choose if users can change the priority of their own jobs or not (Allow user to change priority of his jobs).
   b) Choose who can change the priority of all jobs:
      - No users can change priority of all jobs,
      - All users can change priority of all jobs,
      - Only specified users can change priority of all jobs. In this case, enter the Users that can change the priority of all jobs, separating their names by commas.

4. Choose which users can hold or release which jobs:
   - Users can only hold or release their own jobs,
   - All users can hold or release all jobs,
   - Only specified users can hold or release all jobs. In this case, enter the Users that can hold or release all jobs, separating their names by commas.
4.4. Parameter Assistant Setup

The Parameter Assistant stores public parameters you defined when submitting jobs, and allows you to re-use these parameters when submitting the same job to the same workflow. It works with a SQL database.

1. Install and configure a MySQL or PostGreSQL database (see Setting up a Database for the Parameter Assistant).

2. In the Hub's Preferences, go to the Parameter Assistant tab.
3. Choose your **Database Type**: MySQL or PostGreSQL.
4. Enter the name or the address of the server hosting your database in **Host**. This can be your Odystar server or another server.
5. Enter the **Port** used by your database. This is generally **Server Default**.
6. Click **OK**.

   In the **Hub Statistics** window (Window > Hub Statistics), the **SQL Server** indicator is green, meaning the Hub is connected to the SQL database.

   You will now be able to use the Parameter Assistant in Shuttle.
4.4.1. Setting up a Database for the Parameter Assistant

Download the PostgreSQL, MySQL in ArtPro, Nexus, Odystar, Neo technote from the Download Center. It contains important information about how to install and set up your SQL database.

The technote SQL.zip folder you download also contains setup scripts for using MySQL with Nexus (see below).

1. Download and install MySQL or PostgreSQL (see http://mysql.com or http://www.postgresql.org for more information).

2. Set up a database user for Librarian and the Parameter Assistant, with a supplied script or manually:
<table>
<thead>
<tr>
<th>If you are using...</th>
<th>Do this on your database server...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A MySQL database and an Odystar workflow.</td>
<td>Run the MySQL Permissions Setup.command script, located in your Odystar 4.0/Configuration folder.</td>
</tr>
<tr>
<td>A MySQL database and a Nexus workflow.</td>
<td>Use one of the scripts located in the Technote SQL.zip folder you downloaded from the Download Center:</td>
</tr>
<tr>
<td></td>
<td>• If you installed your database on a Windows system, use the UserScript.bat script.</td>
</tr>
<tr>
<td></td>
<td>• If you installed your database on a Macintosh system, use the UserScript.command script.</td>
</tr>
<tr>
<td>A PostgreSQL database and an Odystar or a Nexus workflow.</td>
<td>You need to set up the user manually.</td>
</tr>
</tbody>
</table>

### 4.5. Shuttle Parameters in Odystar Receive Process Folders

1. Double-click on the **Receive** Process Folder of your Odystar Canvas to open its parameters.

   ![Shuttle Parameters](image)

   - **Queue Type:**
   - **Auxiliary Queue:**
   - **Submit Mode:** No Support for Multiple Files
   - **Main File Filter:**
   - **Limit Visibility Only to Predefined Users**
   - **Username:**
   - **Predefined Users:**

2. In the **Shuttle** tab, click **Enable Shuttle Queue**.
   
   This shows a workflow queue for that Process Folder in Shuttle’s Launch window.
3. Enter a **Queue Type** (for example Proofing Workflows) to be able to filter the workflow queues you see in the Launch window. To set up the workflow queue type filter in Shuttle, see *Filtering Preferences* on page 62.

4. If your canvas has a main and an auxiliary input, enter the name of the auxiliary **Receive Process Folder** as it appears on the canvas in **Auxiliary Queue**.

For example, the following workflow has a main **Receive Process Folder** for RunLists and an auxiliary **Receive Process Folder** for single page PDF files.

In this case, you should enter **Receive Pages** as **Auxiliary Queue** name.

5. Choose the way you want to submit files from Shuttle to this **Receive Process Folder**:
   - Choose **No Support For Multiple Files** to be able to only submit individual files through Shuttle.
   - Choose **Accept Multiple Files** to be able to submit several files at once through Shuttle, either as one or as several jobs.
   - Choose **Main and Support Files** to be able to submit several files at once through Shuttle, as one or as several jobs, and to be able to determine which files are main or support files when submitting.
Note: For more information about submitting multiple files, or a main and support files, see Submitting Multiple Files and Submitting a Main and Support Files.

6. Use the Main File Filter when submitting Multiple Files or Main and Support Files through Shuttle. Enter a part of the main file's name (e.g. "*.odrlst" if your main file is a RunList) so that Shuttle can identify it automatically as the main file.

7. To only show your Shuttle queue to certain users, enable Limit Visibility Only to Predefined Users, and enter their Username(s) in Predefined Users.

4.6. Making Parameters Public for Shuttle in Odystar

Making parameters public in Odystar allows you to fill those parameters in from Shuttle, when you submit files to the Odystar canvas.

1. On your canvas, double-click the gateway whose parameter(s) you want to make public.
2. In the Parameters window that opens, right-click on the parameter you want to make public and select Public Parameter.
This shows the public parameter icon beside it in the Parameters window.

When you submit a file to your workflow through Shuttle, you will see a pop-up with the public parameter(s) for you to fill in.

**Attention:**
If you make a parameter using a Naming Template public, only the first fixed text field in the Naming Template will become public.

If the Naming Template doesn't contain any fixed text, that public parameter will not be visible in Shuttle.

For more information about Naming Templates, please see the Odystar documentation.

4.7. Setting up the Hold Process Folder for Shuttle

When your job is in a **Hold** Gateway in an Odystar workflow, you can do several things from Shuttle:

- route the job towards one of several possible workflow paths,
- open the job as it is at that point of the workflow,
- edit the job's public parameters for the rest of the workflow.

1. In the **Hold** Gateway's **Parameters** dialog, click the **Shuttle** tab.
2. Enable **Require Attention**.
3. Enter a Message to help operators decide on how to route the job. This message will be shown in Shuttle.

4. In the Output Options List parameter group, enter a Message for each choice.

Those messages will be shown in Shuttle.

These choices correspond to different outputs of the Hold Gateway, taking different routes in the workflow.

5. If needed, you can also set the Gateway to change the Status of the job when selecting a choice in Shuttle.

You can assign one of the following statuses to the job:

- Don’t Modify,
- OK,
- Warning,
- Error.
5. Nexus Setup for Shuttle

The NexusSOAPServer makes the Nexus workflows and jobs accessible to the Shuttle clients.

5.1. Setting up the NexusSOAPServer

To set up the NexusSOAPServer, you need to use the NexusManager application to connect to your Nexus server. You can run it on any machine.

1. Do the following to open the NexusSOAPServer’s Preferences:
   a) Launch the NexusManager application.
   b) Connect to a Nexus server.
   c) Still in NexusManager, go to View > Modules, or use the Command + 5 shortcut.
   d) In the Modules dialog, double click on NexusSOAPServer.

This opens the NexusSOAPServer’s Preferences.
2. Enter the port to use for SOAP communication with Shuttle in **Listening Port**.

By default this is port 5182, but if this port is already used by other processes, you should enter the next available port.

3. Enable the **Parameter Assistant** option if you want to be able to re-submit jobs to Nexus using the same parameters. For more information on the **Parameter Assistant**, see *The Parameter Assistant*.

**Note:** This option is only available if Nexus is connected to a MySQL database set up for **Librarian** and the **Parameter Assistant**. For more information, see *Setting up a Database for the Parameter Assistant* and *Connecting Nexus to your Database*.

4. Enable **User Management** if you want to restrict the workflows users see in Shuttle to those they have access to in **NexusManager**.

**Note:** In this case, make sure that the Shuttle user name and the **NexusManager** user name are the same. See *Shuttle Clients Connecting to Any Server* on page 58 to know how to define your Shuttle user name.

5. Choose between **Direct File Access** and **Shared Folder**.
• Choose **Direct File Access** for Shuttle to open files directly from the server, without copying them to a temporary folder.

**Note:** Choose **Direct File Access** if you want to be able to open files from ArtPro’s Shuttle.

• Choose **Shared Folder** to use a temporary folder (use the browse button to select it). Nexus will copy files to that folder, and Shuttle will open them from there.

**Note:** Your shared folder needs to have the correct permissions and to be accessible from the Nexus server and all Shuttle clients. See *Setting up a Shared Folder or a HotFolder for Shuttle*.

6. Click **OK**.

### 5.1.1. Setting up a Shared Folder or a HotFolder for Shuttle

1. Create a folder either on your Nexus server or on another server.
2. If you created your folder on another server:
   a) Give it read and write permissions for the user under which you installed Nexus on your Nexus server.
   b) Mount it on your Nexus server.
3. Give your folder read and write permissions for all Shuttle users.
4. If the Spool Folder has the required permissions, your Shuttle applications can auto-mount it when you submit a job to a workflow.

   - If Shuttle fails to auto-mount your spool folder, mount it manually on your Shuttle client machine(s).

### 5.1.2. Making Nexus Broadcast over Bonjour

You can set your Nexus server to broadcast over the Apple Bonjour network, so you can connect to it from Shuttle without needing to know its IP address.

1. On your Nexus server, launch the **NexusConfig** application.
2. In the **Nexus** tab, select **Broadcast on the Local Network using Bonjour**.
3. Click Apply Changes.

5.1.3. Setting up a Database for the Parameter Assistant

Download the PostgreSQL, MySQL in ArtPro, Nexus, Odystar, Neo technote from the Download Center. It contains important information about how to install and set up your SQL database.

The Technote SQL.zip folder you download also contains setup scripts for using MySQL with Nexus (see below).

1. Download and install MySQL or PostgreSQL (see http://mysql.com or http://www.postgresql.org for more information).

2. Set up a database user for Librarian and the Parameter Assistant, with a supplied script or manually:

<table>
<thead>
<tr>
<th>If you are using...</th>
<th>Do this on your database server...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A MySQL database and an Odystar workflow.</td>
<td>Run the MySQL Permissions Setup.command script, located in your Odystar 4.0/Configuration folder.</td>
</tr>
</tbody>
</table>
| A MySQL database and a Nexus workflow. | Use one of the scripts located in the Technote SQL.zip folder you downloaded from the Download Center:  
  • If you installed your database on a Windows system, use the UserScript.bat script. |
If you are using... | Do this on your database server...
---|---
If you installed your database on a Macintosh system, use the UserScript.command script. |  
A PostgreSQL database and an Odystar or a Nexus workflow. | You need to set up the user manually.

### 5.1.4. Connecting Nexus to your Database

1. On your Nexus server, launch the **NexusConfig** application.
2. In the **Librarian** tab, choose the type of database you are using.

![Nexus Configuration Screen](image)

3. If you are using a **MySQL** or **PostgreSQL** database:
   a) enter the database **Server Address**,  
   b) click **Test...** to test the connection to the database server.
4. Click **Apply Changes**.

5.2. **Enabling Shuttle in a Nexus Hot Folder**

1. When creating a Nexus workflow, choose **Hot Folder** as **Input Type**.

![Nexus Workflow Setup](image)

2. In the dialog that opens, browse to your **Hot Folder** (or use the default one).

![Hot Folder Settings](image)

Your **Hot Folder** needs to have the correct permissions and to be accessible from the Nexus server and all Shuttle clients. See **Setting up a Shared Folder or a HotFolder for Shuttle**.

3. In the **Settings** tab, enable **Show in Shuttle**.

   This shows a workflow queue for that Hot Folder in Shuttle's Launch window.
5.3. Making Parameters Public for Shuttle in Nexus

Making parameters public in Nexus allows you to fill those parameters in from Shuttle, when you submit files to the Nexus workflow.

1. In your workflow, double-click the activity whose parameter(s) you want to make public.
2. In the settings window that opens, right-click the parameter to make public and select Public.
3. Click **OK**.

4. Go to **View > Monitors** or use **Command + 3**.
5. Double-click your Hot Folder’s name to open its parameters.
6. In the NeXML tab, click the **Upload Public Parameters** button.
   
   This creates a `PublicParameters.xml` file containing your public parameters.
7. If necessary, click the **Edit**... button to edit your public parameters (for example to change your public parameters’ names or their default value).

8. Click **OK** to save your public parameters in your workflow Hot Folder.

When you submit a file to your workflow through Shuttle, you will see a pop-up with the public parameter(s) for you to fill in.
5.4. Setting up the Wait for OK Activity for Shuttle

When your job is in a **Wait for OK** Activity in a Nexus workflow, you can do several things from Shuttle:

- **Release** the job to the rest of the workflow or **Abort** (stop) it,
- open the job as it is at that point of the workflow,
- edit the job's public parameters for the rest of the workflow.

- To be able to identify and open the files that are in the **Wait for OK** Activity from Shuttle, give this Activity a label in your workflow.

  To do this, select the **Wait for OK** Activity and enter a **Label** at the bottom left of the **Nexus Workflow Editor** window.
This label will be visible to the Shuttle operator when he has to release or abort the job...

or when he wants to open one of the job files.

5.5. Setting up the Decision Activity for Shuttle

When your job is in a Decision Activity in a Nexus workflow, you can do several things from Shuttle:

• route the job towards one of several possible workflow paths,
• open the job as it is at that point of the workflow,
• edit the job's public parameters for the rest of the workflow.

1. In your workflow, give a label to the Decision Activity.
To do this, select the **Decision** Activity and enter a **Label** at the bottom left of the **Nexus Workflow Editor** window.

2. Give a label to each of the Activities that you can route the job to.

3. Double-click your **Decision** Activity to open the **Decision** window.

4. Drag the arrow of the first Activity you can route your job to (**PDF Trapper** in the example) in the **Decision** window. Do the same thing for every other Activity you can route your job to (**Rasterise Separations** in the example).

   Your Activities’ labels are listed under **Option Name**.
5. You can modify every Option Name by double-clicking it.

6. If needed, you can choose a Default Activity and give a Timeout for the decision. This way, the job will be released automatically to the Default Activity if the operator hasn’t routed it within the time specified.

7. Click OK.

The Shuttle operator will see the Decision Activity’s label and the Option Names of the Activities following it when he has to route the job to one of the possible workflow paths.

He will also be able to open the file in the Decision Activity based on its label.
6. Shuttle Clients Setup

6.1. Connecting your Shuttle Client to your Workflow Server

6.1.1. Shuttle Clients Connecting to Any Server

The Shuttle (in all its forms) can connect to one or more Automation Engine servers.

1. Launch Shuttle (standalone or the editor plug-in).
2. Open the Preferences.

<table>
<thead>
<tr>
<th>In...</th>
<th>go to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Illustrator</td>
<td>(Mac)Illustrator &gt; Preferences &gt; Esko &gt; Shuttle Preferences...</td>
</tr>
<tr>
<td></td>
<td>(Windows) Edit &gt; Preferences &gt; Esko &gt; Shuttle Preferences...</td>
</tr>
<tr>
<td>ArtPro</td>
<td>ArtPro &gt; Preferences... or use Command + K</td>
</tr>
<tr>
<td>PackEdge/Plato</td>
<td>(Windows) Edit &gt; Preferences &gt; Server&amp;Resources</td>
</tr>
<tr>
<td>Neo</td>
<td>Neo &gt; Preferences... or use Command + , (comma)</td>
</tr>
<tr>
<td>FastImpose Standalone</td>
<td>Tools &gt; Shuttle Preferences...</td>
</tr>
</tbody>
</table>

3. In the Servers tab (Advanced tab for Neo), click + at the bottom of the Servers list.

This dialog opens:
4. Enter your **User Name** and **Password**.
   - When connecting to an Automation Engine server, enter the **User Name** and **Password** you use to log in to the Pilot (the password can be blank if your server is configured to accept this).
     
     You will have the same access rights in Shuttle as you have in the Pilot (for example the right to set processing priorities or not).

   - When connecting to a Nexus server, enter the **User Name** and **Password** you use to login to the NexusManager if your Nexus server has **User Management** enabled (see [Setting up the NexusSOAPServer](#) on page 43).
     
     You will be able to access the same workflows as from NexusManager.

     **Note:** If **User Management** is not enabled, you will be able to access any workflow on your server. In this case, you can enter any user name you like (without a password): it will only be used for filtering files in the **Shuttle** window.

   - When connecting to an Odystar server, you will be able to access any workflow on your server. You can enter any user name you like (without a password): it will only be used for filtering files in the **Shuttle** window.

5. To connect to a server broadcasting over the 'Bonjour' network (Odystar servers orBonjour-enabled Nexus servers):
   a) Select **Bonjour** in the **Browse Method** list,
   
   b) Select your server's name in the **Bonjour** list.

   **Note:** You don't have to enter the server address and server port manually.

6. To connect to a server *not* broadcasting over the 'Bonjour' network (Automation Engine servers or non-Bonjour-enabled Nexus servers):
   a) Select **Manual** in the **Browse Method** list
   
   b) Enter your server’s name or IP address in **Server Address**
   
   c) Fill in the **Server Port** used by your server.
Note:
When connecting to an Odystar server, enter the port used for SOAP communication between Shuttle and your Odystar Hub (see Connection Setup).
When connecting to a Nexus server, enter the Listening Port of the NexusSOAPServer (see Setting up the NexusSOAPServer).
When connecting to an Automation Engine server, enter the port you defined in Configure.

7. Click Add.
This adds a connection to your server in the Servers list.

- To remove the connection to a server, select it in the Servers list and click -.
- To check or edit a server's settings, double-click it in the Servers list.

Note:
If you are using the Shuttle plug-in with other DeskPack plug-ins, and you have set up a server connection with the Server Connection Assistant, you will see this connection in bold in the Shuttle plug-in's Servers list (after restarting Illustrator).
You will be able to change the user name and password if necessary, but you will not be able to remove this connection from the Shuttle plug-in.
Learn more about the Server Connection Assistant in the Adobe Illustrator Client documentation.

6.1.2. Shuttle Clients Connecting only to Automation Engine

The Shuttle clients in PackEdge, Plato and FastImpose Server can only connect to one Automation Engine server.

1. Launch the application.

2. Open the Preferences.

- In PackEdge or Plato, go to Edit > Preferences or use Ctrl+Alt+Shift+P.
- In FastImpose Server, go to Tools > Options...

3. In the Server&Resources tab (the Server tab for FastImpose Server):
   a) Select Connect to Automation Engine Server.
   b) Enter the Automation Engine Server Name and click Check.
      You should see a message saying the server is up and running.
   c) Select 'Login with the following user account settings', and fill in the User Name and Password you use to login to the Pilot.
      If the connection is successful, you will see a green dot and the message 'Connected as user ...'
Tip: If you are a Pilot on the same computer, or another Shuttle client (either PackEdge, Plato or FastImpose Server), you can select 'Login automatically with user name and password from other application connected to the server'. This way, if you are already logged in to the Pilot or the other client application, you won’t need to log in when starting PackEdge / Plato / FastImpose Server.

4. Restart your application.

6.2. Defining Preferences

You can define Shuttle-specific preferences in the Shuttle plug-in.

6.2.1. Display Preferences

You can choose how to display your workflows in the Shuttle plug-in.

1. In the Preferences dialog, click the General tab.
2. Choose how to display the workflow names in the Launch window:

<table>
<thead>
<tr>
<th>Set the Workflow Name Format this way:</th>
<th>to display the workflow name like this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Workflow Entry</td>
<td>Receive</td>
</tr>
<tr>
<td>Include Server Name</td>
<td></td>
</tr>
<tr>
<td>Include Workflow Entry</td>
<td>Receive@preflight</td>
</tr>
<tr>
<td>Include Server Name</td>
<td></td>
</tr>
<tr>
<td>Include Workflow Entry</td>
<td>Receive@preflight:macpro</td>
</tr>
<tr>
<td>Include Server Name</td>
<td></td>
</tr>
</tbody>
</table>
3. Choose how to sort the workflows in Shuttle’s Launch window:

- Choose **By Workflow Name** to display all the entry points (Receive Gateway, Hot Folder...) of a same workflow together.
- Choose **By Workflow Entry** to display all the entry points in alphabetical order, regardless of the workflow they belong to.

### 6.2.2. Public Parameters Preferences

When you have to select some or all of the file’s inks for a public parameter, the public parameters window shows an ink list.

- To add one of your file’s inks, click + then select it in the drop-down list.
- To add all of your file’s inks, right-click the ink list and select **Expand Ink List**.
- To remove one of your file’s inks, click − beside it in the inks list.

By default, the ink list is expanded when it is the most used case for that public parameter (for example, for Proof, RIP or Export workflow steps).

In the Shuttle standalone and plug-in preferences, you can choose to have the ink list expanded or not.

To do this, select or deselect **Automatically Expand Ink Lists** in the **General** tab of the preferences.

**Note:** This is only applied when it makes sense to add all of your file’s inks by default (for example, it is not applied for parameters removing inks from your file).

### 6.2.3. Filtering Preferences

If you connect to several servers or to a server with many canvases or workflows, you may want to only display certain canvases / workflows when submitting files from the Shuttle plug-in.

**Note:** This is only supported for Nexus and Odystar workflows.
1. In the **Servers** tab of Shuttle's Preferences dialog, enable **Filter On Workflow Type**.

2. At the bottom of the **Workflow Types To Show** list, click the **+** button and enter the workflow type you want to show in the Launch window.
   - For Odystar canvases, you need to define workflow types in the **Receive** Process Folders’ parameters. See *Shuttle Parameters in Odystar Receive Process Folders*.
   - For Nexus workflows, the workflow type is the name of the workflow.
     The workflow name format to use here doesn’t depend on what you have set in the **Workflow Name Format** parameter in the **General Preferences**. It is always [hotfolder name]@[workflow name].

3. Click the **+** button again if you want to add more workflow types to the list.
   To remove a workflow type from the **Workflow Types To Show** list, select it and click the **−** button.

**Note:**
The Shuttle plug-in filters only on the workflow name, for Odystar, Nexus or Automation Engine servers.
For example, add *(DeskPack Only)* in the filter to only show DeskPack-related workflows on your Automation Engine server (whose name contain “*(DeskPack Only)*”).

### 6.2.4. Workflow Units Preferences

Use the **Units** tab of the Shuttle plug-in Preferences to define the units you want to use when launching workflows on your file(s).

1. Choose to define the **Resolution** in **Pixels Per Millimeter** or **Pixels Per Inch**.
2. Choose to define the **Screen Ruling** in **Lines Per Millimeter** or **Lines Per Inch**.

   These units will be used when you submit a file to a workflow with public parameters.

   For example, if you chose a **Lines Per Inch Screen Ruling** and you submit a file to an Odystar RIP workflow with the **Ruling** as a public parameter, the public parameters pop-up will show the **Ruling** in Lines Per Inch.
Launch
File: a.pdf
Parameters
Proofing RIP
Ruling: 85lpi

Cancel  OK
7. Launching Files into a Workflow

7.1. Launching Tasks from Adobe Illustrator (the Shuttle Plug-in)

**Note:** To launch tasks from Adobe Illustrator, you need to install the Shuttle Plug-in. Download it from [https://mysoftware.esko.com/](https://mysoftware.esko.com/).

Follow these steps to launch a task or workflow on the file that you have open (and in front of any other open files):

1. Go to **File > Launch Workflow...** or use **Option + CMD + Z**.

2. In **Launch As**, choose **Normalized PDF** to copy a Normalized PDF version of your file onto the DeskPack Container. Choose **Adobe PDF** to copy the Adobe Illustrator PDF version.
   
   - **Normalized PDF** uses the 'PDF Export' plug-in to convert your Illustrator file to Normalized PDF. To refine the conversion, you can select one of the PDF Export Presets, or click **Settings...** and edit the **PDF Export Settings**. These changes are not saved.
   
   - **Adobe PDF** uses the Adobe PDF preset 'Illustrator Default'.

   **Note:** 'Color Conversion' and 'Profile Inclusion Policy' are not part of the preset 'Illustrator Default', but **Launch Workflow** will apply color conversion with the last settings used.
3. If you want to link your file to an existing Automation Engine Job, fill in an existing Job ID and/or Job Sub ID. The task on the Normalized PDF will then run in that Job context, which means it can use the Job Setup parameters via SmartNames.

   **Note:** If your open file is already saved in an Automation Engine Job Folder, the Job ID and/or Job Sub ID will be filled automatically.

4. Select the task or workflow you want. If it has public parameters, fill them in.
5. Click Launch. If your file was changed since the last save, you can click Save and Launch to first save your document and then launch the task.

7.2. Launching Tasks from ArtPro

In **Preferences > Servers > Shuttle**, add the name of your Automation Engine server.

**Note:** In that same dialog, the tab Automation Engine serves to define other preferences related to that server. You do not need to fill that one in when you only need this connection to the "Shuttle Server".

1. To launch a workflow on the currently open file, go to **File > Launch Workflow...**
   
   This opens the Launch Workflow dialog.
2. **Launch as**: Your open file is an ArtPro file, but you can choose as which file type you will send it to the selected workflow.

<table>
<thead>
<tr>
<th>If your workflow is...</th>
<th>you can launch the file as...</th>
<th>with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a Nexus workflow</td>
<td>PDF</td>
<td>any of the available PDF flavors.</td>
</tr>
<tr>
<td>accepting PDF files as input,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ArtPro</td>
<td>with the included images (TIFF, EPS...) or without (only the ArtPro and the ArtPro CT file)</td>
</tr>
<tr>
<td>a Nexus workflow</td>
<td>PS for Nexus</td>
<td>settings that you need to define in the <strong>Print</strong> dialog.</td>
</tr>
<tr>
<td>accepting ArtPro files as input,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>an Odystar workflow,</td>
<td>PDF</td>
<td><strong>PDF for Press</strong> only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If you want to add your file to the Job Folder of an Automation Engine Job, select it from the Job list or fill in its Job ID and/or Job Part ID.

Note: Use the Search... button to see a list of active Jobs, including some of their metadata.

4. If you want to add your file to an Automation Engine Product, select it from the Products list or fill in the Product ID and/or Product Part ID.

Note: Use the Search... button to see a list of your server's Products.

5. Select the workflow you want to launch.

6. Fill in any of its Public Parameters.
If you want to go back to the default parameters values after changing them, click 'Reset To Defaults'.

7. Click Launch.

7.3. Launching Tasks from Neo

1. Go to File > Launch Workflow...

   This opens the Launch Workflow window.

   ![Launch Workflow window]

2. Select the workflow you want to launch on your file in the workflow list.
3. If your workflow has public parameters, you can fill them in the same window.

   For more information on public parameters, see:
   - Using Public Parameters in Automation Engine on page 22,
   - Making Parameters Public for Shuttle in Odystar on page 40,
   - Making Parameters Public for Shuttle in Nexus on page 49.
4. Click Launch to launch the workflow on your file.

7.4. Launching Tasks from PackEdge or Plato

⚠️ Attention: You must save your file on an Automation Engine Container before you can launch a task on it from within PackEdge or Plato.

1. Go to File > Launch Workflow...
The dialog lists all public tickets. When selected, a ticket shows its public parameters.

2. Select the task or workflow you want. If it has public parameters, fill them in.
3. Click **Launch** to launch the workflow on your open file.

**Tip:** To access this "Shuttle Server" easily in the future (without using the menus):

1. Go to **Window > Toolbars > Shuttle** to open the Shuttle palette.
2. Drag it into your application's toolbar.
3. Click ![Launch Workflow](image) to open the **Launch Workflow** window. Click ![Shuttle](image) to open the **Shuttle** window where you can monitor and manage the launched tasks.

### 7.5. Launching Tasks from FastImpose

When working with FastImpose Server, you must save your file on an Automation Engine Container before you can launch a task or workflow.

1. Go to **File > Launch Workflow...**
   The dialog lists all public tickets. When selected, a ticket shows its public parameters.
2. Choose what file type you want to launch your file as.
   - When working with FastImpose Server, you can only launch your file as an IMP file.
   - When working with FastImpose Standalone, you can launch your file either as a JDF or a PDF file.

   Click the **Settings...** button to set **JDF** or **PDF Export Preferences**. Learn more in the **FastImpose documentation**.
3. Select the workflow you want. If it has public parameters, fill them in.
4. Click **Launch** to launch the workflow on your file.
8. Monitoring Files

8.1. The Shuttle Window

The Shuttle window shows all files belonging to you or to all users, in all workflows your Shuttle is connected to.

To open a Shuttle window:

<table>
<thead>
<tr>
<th>In...</th>
<th>go to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illustrator</td>
<td>Window &gt; Esko &gt; Shuttle</td>
</tr>
<tr>
<td>ArtPro, Neo, PackEdge and Plato</td>
<td>Window &gt; Shuttle</td>
</tr>
<tr>
<td>FastImpose</td>
<td>View &gt; Shuttle</td>
</tr>
</tbody>
</table>

The Shuttle window shows each file’s name, status, the workflow the file is in, etc.

It has several areas: buttons, a filter to view files, the file list, and the Inspector panel that shows more information.

8.1.1. The Shuttle Window Buttons

With those buttons you can perform basic tasks on the file selected in the Shuttle window.
Note: You can also access these tasks in each file’s context menu.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hold</strong></td>
<td>With the Hold button you can put a file on hold from Shuttle.</td>
</tr>
<tr>
<td><strong>Release</strong></td>
<td>With the Release button you can release a file that is on hold from Shuttle.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>With the Delete button you can delete a file.</td>
</tr>
<tr>
<td><strong>Abort</strong></td>
<td>With the Abort button you can cancel your workflow’s processing from Shuttle.</td>
</tr>
<tr>
<td><strong>Users</strong></td>
<td>With the Users button you can choose to show only your files, or all users’ files.</td>
</tr>
<tr>
<td><strong>Inspector</strong></td>
<td>With the Inspector button you can open (or close) the Inspector panel to see more information.</td>
</tr>
</tbody>
</table>

See also:

- Holding or Releasing a File on page 80,
- Deleting a File from your Workflow on page 83,
- Showing Only Your Files / Everybody's Files on page 78.
- The Inspector Panel on page 77.

### 8.1.2. The Connection to Workflow Servers

In case of a connection problem with one or more server(s) you added in the Preferences, the Shuttle window shows a connection status:

- If at least one of the servers isn’t running, it shows: ![Connection to some servers failed]
- If none of the servers are running, it shows: ![No connection to servers]

Go to the Preferences and check the servers’ list.

**Tip:** In the Shuttle plug-in, you can click the colored dot to open the Servers Preferences.

To edit the connection to a server which is not running anymore, see Shuttle Clients Connecting to Any Server on page 58.
8.1.3. The Shuttle Window Filter

In the **Shuttle** Window, you can set criteria to filter files.

![Search Criteria](image)

Use the filter to show only certain files, e.g. files for a specific user, for a specific workflow or process, by status, based on the file name...

![Criteria](image)

You can set extra criteria by clicking the + button, and remove criteria by clicking the - button.

8.1.4. The Files List

The files list shows all files in the selected server belonging to either just you or all users.

It shows:

- the file’s Run Status and File Status (see below),
- its name,
- the Workflow (Canvas for Odystar) processing the file,
- the Process Folder the file is in (for Odystar), the percentage of processing completed (Nexus) or workflow/task type (Automation Engine),
- the user it belongs to,
- the time the file entered the workflow,
- the job ID (if any),
- the job Part ID (if any),
- the server name (if you are connected to several servers).

**Note:** Click on the column headers to rearrange the files by file status, name, workflow, starting time...

---

**Run Status**

The Run Status shows you how the processing is going so far.

- File finished.
### File Status

The File Status shows you the final processing state of the file.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark]</td>
<td>OK.</td>
</tr>
<tr>
<td>![Information]</td>
<td>Info: more information on the file is available.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>Warning.</td>
</tr>
<tr>
<td>![Error]</td>
<td>Error.</td>
</tr>
<tr>
<td>![FatalError]</td>
<td>Fatal error: The file could not be processed.</td>
</tr>
</tbody>
</table>

For example, ![Information] means that the file is on hold and that it generated a warning.

### 8.1.5. The Context Menu

Each file's context menu allows you to perform several actions on the file, or to get more information about the file.
Use this... | to...
---|---
Open | open either:
  - the main file,
  - another file (that has a tag in an Odystar canvas or a label in a Nexus workflow),
  - all the files,
  - the file folder.
Preview (QuickLook) | show one of the files in QuickLook (main file, another file...).
You can also use the Space shortcut to open the main file.
**Note:** This is only available on Mac OS X 10.5 (Leopard) and newer.
Edit Parameters... | edit the file's public parameters for the remainder of the workflow (after a Hold Gateway or a Decision or Wait for OK Activity).
**Note:** This is only available for files with public parameters that are in a Hold Gateway in Odystar, or in a Decision or Wait for OK Activity in Nexus.
Hold | put a file on hold from Shuttle.
Release | release a file that is on hold from Shuttle.
Priority | increase or decrease a file's priority rank.
Show Log... | open the log of the selected file.
Open Relations... | open the relations of the selected file.
Attention | route a file that needs attention.
<table>
<thead>
<tr>
<th>Use this...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> This shows the message and choices set in your <strong>Hold</strong> Gateway in Odystar, your <strong>Decision</strong> or <strong>Wait for OK</strong> Activity in Nexus or your <strong>Wait for Action</strong> (Checkpoint) workflow step in Automation Engine.</td>
<td></td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>delete the selected item from the server (this deletes the task for Automation Engine workflows, and the job and job files for Odystar and Nexus workflows).</td>
</tr>
<tr>
<td><strong>Abort</strong></td>
<td>cancel the selected file’s processing in your workflow.</td>
</tr>
<tr>
<td><strong>Filter on Job ID</strong></td>
<td>show only the files that have the same Job ID as the one you selected.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This is only available for files that are in an Automation Engine job.</td>
</tr>
</tbody>
</table>

See also:

- *Opening Files / the Enclosing Folder* on page 79,
- *Changing a File's Public Parameters* on page 80,
- *Holding or Releasing a File* on page 80,
- *Changing a File's Priority* on page 81,
- *Opening the Log* on page 82,
- *Viewing a File's Relations*,
- *Routing Files that Need a Decision* on page 82,
- *Deleting a File from your Workflow* on page 83.

### 8.1.6. The Inspector Panel

The **Inspector** panel shows information about the file you selected.
In the **More Info** area, you can raise or lower the file's priority. If you have sent several files at once to your workflow, the **Files** area will list them all. The **Messages** area shows any messages generated by the workflow during processing.

**8.1.7. Showing Only Your Files / Everybody's Files**

- Click 🔄 to only show your files in the Shuttle window.
- Click 🔄 to show all users’ files.
9. Working with Shuttle when your File is Processing

9.1. Opening Files / the Enclosing Folder

You can open any file that has a tag (from an Odystar canvas) or a label (from a Nexus workflow) from Shuttle. You can also open the enclosing folder (for Nexus workflows).

- To open the main file, double-click it in the Shuttle window list.
- To open another related file:
  a) right-click the main file in the Shuttle window list,
  b) select Open in the context menu,
  c) click the name (files in Automation Engine workflows), tag (files in Odystar workflows) or label (files in Nexus workflows) of the file you want to open.

Depending on your workflow type and on where your job is in your workflow, opening the main file has different results:

<table>
<thead>
<tr>
<th>For...</th>
<th>if your job is...</th>
<th>opening the “main” file opens...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Odystar workflows</td>
<td>paused in a Hold Process Folder</td>
<td>the file as it is in the Hold Process Folder (modified by the previous Gateways in the workflow).</td>
</tr>
<tr>
<td></td>
<td>running anywhere else in the workflow</td>
<td>the file as it is before entering the current Process Folder (modified by the previous Gateways in the workflow).</td>
</tr>
<tr>
<td>Nexus workflows</td>
<td>paused in a Decision or Wait for OK Activity</td>
<td>the file as it is in the Decision or Wait for OK Activity (modified by the previous Activities in the workflow).</td>
</tr>
<tr>
<td></td>
<td>running anywhere else in the workflow</td>
<td>the input file (unmodified by the workflow).</td>
</tr>
<tr>
<td>Automation Engine workflows</td>
<td>paused in a Wait for Action (CheckPoint) step</td>
<td>the input file of the Wait for Action (CheckPoint) step.</td>
</tr>
<tr>
<td></td>
<td>running anywhere else in the workflow</td>
<td>the output file of the last workflow step completed.</td>
</tr>
</tbody>
</table>
9.2. Changing a File's Public Parameters

When a file is in a Hold Gateway in Odystar, or in a Decision or Wait for OK Activity in Nexus, in a workflow that has public parameters, you can edit the file's public parameters for the remainder of the workflow (after the Hold Gateway or the Decision / Wait for OK Activity).

- To do this, right-click it and select Edit Parameters...

**Note:** This is only available for files with public parameters that are in a Hold Gateway in Odystar, or in a Decision or Wait for OK Activity in Nexus.

This opens the public parameters pop-up for you to edit the public parameters.

9.3. Holding or Releasing a File

Check which files you can hold or release:

<table>
<thead>
<tr>
<th>For..</th>
<th>you can hold or release...</th>
<th>when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nexus workflows</td>
<td>your own files only</td>
<td>always</td>
</tr>
<tr>
<td>Odystar canvases</td>
<td>your own files only</td>
<td>by default</td>
</tr>
<tr>
<td></td>
<td>everybody's files</td>
<td></td>
</tr>
</tbody>
</table>

- **All users can hold or release all files** is enabled in the Hub's Preferences. See *Access Rights Setup*.
- your user name is in the list of users that can hold or release all files in the
### 9.4. Changing a File's Priority

Check which files' priority you can change:

<table>
<thead>
<tr>
<th>For..</th>
<th>you can change the priority of..</th>
<th>when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nexus workflows</td>
<td>your own files only</td>
<td>always</td>
</tr>
<tr>
<td>Odystar canvases</td>
<td>no files</td>
<td>by default</td>
</tr>
<tr>
<td></td>
<td>your own files only</td>
<td>Allow user to change priority of his files is enabled in the Hub's Preferences. See Access Rights Setup.</td>
</tr>
<tr>
<td></td>
<td>everybody's files</td>
<td>your user name is in the list of users that can change the priority of all files in the Hub's Preferences. See Access Rights Setup.</td>
</tr>
<tr>
<td>Automation Engine tickets</td>
<td>everybody's files</td>
<td>your user has sufficient privileges in the Automation Engine Pilot.</td>
</tr>
</tbody>
</table>

To change the priority of a file, you can either:

- right-click it and select **Priority > Increase** or **Priority > Decrease** in the context menu.
- select it and click either + or − beside Priority in the More Info area of the Inspector (to either increase or decrease the file's priority).
9.5. Opening the Log

- To open a file's log, right-click it and select Show Log...

9.6. Routing Files that Need a Decision

When your file is paused in a workflow and needs a user decision to take one of several workflow paths, you can route it from Shuttle.

This is the case for files in a Hold Gateway in Odystar, in a Decision or Wait for OK Activity in Nexus, or in a Wait for Action (Checkpoint) workflow step in Automation Engine.

**Note:**

The user name used in the Checkpoint step settings and the user name used in Shuttle to connect to Automation Engine must match.

If they don't, you can still see the file(s) to route, but only when displaying everybody's files in Shuttle (in Show All mode).

In the Shuttle window, you see an icon (◯) indicating that the file needs attention.

The Inspector panel also shows an attention icon, and the notification defined in your workflow.

To route the file, you can either use:

1. the Shuttle processing list:
   a) Right-click the entry that requires attention (the exact workflow step and not the main workflow entry) and select Attention in the context menu.
This shows the message and output options set in your Hold Gateway, Decision or Wait for OK Activity, or Checkpoint step.

b) Select one of the output options to route the file.

2. the Inspector panel:
   a) Select the file with the attention icon in the list to show it in the Inspector panel.
   b) Click ![attention icon] and select one of the output options to route the file.

9.7. Deleting a File from your Workflow

Check which files you can delete:

<table>
<thead>
<tr>
<th>For..</th>
<th>you can delete...</th>
<th>when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nexus workflows</td>
<td>your own files only</td>
<td>always</td>
</tr>
<tr>
<td>Odystar canvases</td>
<td>your own files only</td>
<td>by default</td>
</tr>
<tr>
<td></td>
<td>everybody's files</td>
<td>• All users can delete all files is enabled in the Hub's Preferences. See Access Rights Setup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• your user name is in the list of users that can delete all files in the Hub's Preferences. See Access Rights Setup.</td>
</tr>
<tr>
<td>For..</td>
<td>you can delete...</td>
<td>when...</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Automation Engine tickets</td>
<td>everybody's files</td>
<td>your user has sufficient privileges in the Automation Engine Pilot.</td>
</tr>
</tbody>
</table>

- To delete a file, you can either:
  - select it and click the **Delete** button,
  - right-click it and select **Delete**.